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Photoshop: HDR
HDR som du vill ha det

For manga har begreppet HDR blivit synonymt med surrealistiska
bilder som for tankarna till nagon slags marklg drogtripp. Men det
ar langt ifran hela sanmingen. Ratt anvdand kan HDR-tekniken ge
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dig fantastiska mojhigheter till battre bilder.
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LAT 0SS SLA fast det med en gang — HDR 4r inte i for-
sta hand ett sitt att skapa bisarra fantasibilder, dven
om tekniken ofta utnyttjas i detta syfte. Och det ar
inte sa underligt. Varje gang det uppstar nya tek-
niska mojligheter experimenteras det friskt och ofta
overdrivs den nya spdnnande effekten. Men fran
borjan var mélet med HDR det omvénda — att skapa
mer realistiska bilder.

VAD AR HDR?

Om du vill forsta hur tekniken bakom HDR-bilder
fungerar maste du forst ha klim pa begreppet
»dynamiskt omfang«. For att krangla till det anger
det dynamiska omféanget lite olika saker beroende
péa vad man talar om. Ute i verkligheten &r det ett
matt pa forhallandet mellan den hogsta och ldgsta

ljusstyrkan som é&r nérvarande. En digitalkameras
dynamiska omfang anger lite forenklat forhallandet
mellan det ljusaste och morkaste som sensorn kan
aterge i en exponering utan att detaljer gar forlo-
rade.

HDR star for High Dynamic Range och som
namnet antyder handlar det om att dstadkomma
ett stort dynamiskt omfang — storre dn det kameran
Klarar av att fanga i en enda exponering.

Du har helt sidkert upplevt hur det under vissa
ljusforhallanden inte gar att hitta en optimal expo-
nering. Ska du vilja utfratt himmel eller kolsvart
forgrund? Ska du fanga rummet du star i eller par-
ken utanfor fonstret? For du kan inte fa bade och.
Pa grund av kamerans begridnsningar tvingas du
gora ett val.



Vid normal exponering maste fotografen vélja mellan kritvit him-
mel och svart férgrund.

Det dr precis det hidr problemet HDR-tekniken ska
rada bot pa. Tack vare HDR kan du alltsa visa detalj-
erna bade i bildens ljusaste och morkaste tonomra-
den. I teorin blir det en mer realistisk bild eftersom
vara Ogon inte alls har samma begrinsning som
kameran. Vi anpassar oss blixtsnabbt efter olika
ljusforhéllanden och ser bade prylarna inne i den
morka vedbon och den soliga dngen utanfor.

En HDR-bild kan visa bade kvéllshimlen och detaljerna i férgrunden.

REALISM AR INTE ALLTID SA REALISTISKT
Det paradoxala dr att dven bilder som ligger nér-
mare det vi upplever med vara ogon kan kénnas
overkliga. Forklaringen dr forstds att vi dr sa invan-
da vid hur ett »normalt« fotografi ser ut att vi ome-
delbart reagerar nir nagot avviker. Det traditionella
fotografiet har fatt definiera vad som &r en korrekt
avbildning av verkligheten. Sedan hjalper det for-
stas inte till att manga av HDR-bilderna vi mdoter &r
kraftigt 6verdrivna.

Sadana hér extremt 6verdrivna varianter finns i 6verfiéd pa natet
och har bidragit till HDR-teknikens daliga rykte.

Tanken bakom den hiér artikeln dr att visa hur HDR
kan vara ett fantastiskt verktyg, dven for dig som
inte gillar de surrealistiska varianterna. Sarskilt slut-
delen behandlar hur du kan dstadkomma mer ater-
héllsamma resultat.

HUR FUNGERAR DET?

I praktiken bygger HDR pa att du tar flera bilder av
samma motiv, med varierande expo-
neringsgrad. Dessa kombineras sedan
ihop i datorn till en enda bild med hjélp
av speciell mjukvara. Resultatet blir en
bild som i idealfallet tidcker hela det dy-
namiska omfanget.

For att detta ska vara mojligt har
HDR-bilder 32 bitar per fargkanal. For-
delen med det é&r att all information kan
representeras med flyttal (decimaltal) i
stéllet for heltal som ér fallet med bilder i
8 eller 16 bitar. Mer information fér plats
och sma skillnader kan atskiljas béttre.

Problemet &r att det dynamiska om-
fanget hos de flesta skdrmar och skrivare
ir dannu mer begridnsat dn en kameras.
For att en HDR-bild inte ska se grislig ut
pé skidrmen eller utskriften maste ytterli-
gare ett steg till som kallas tonmappning
(eng: tone mapping). Tonmappningen
konverterar HDR-bild-en tillbaka till en
vanlig 8 eller 16 bitars bild som kan bild-
behandlas, visas upp och skrivas ut pre-
cis som vanligt. I dagens programvara
sker oftast konverteringen helt automatiskt.

NAR PASSAR DET?

Eftersom HDR-tekniken kriver flera bilder av sam-
ma motiv dr det statiska scener som fungerar bést.
Triadgrenar som vajar for mycket i vinden eller fly-
gande faglar riskerar att forstora slutresultatet. Da-
gens HDR-mjukvara har visserligen verktyg for att
kompensera for detta, men resultatet blir inte alltid
tillfredsstéllande.
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HDR och naturfoto
gillar varandra, inte
minst med tanke pa
att motiven ofta ar

statiska.
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Traditionellt har naturlandskap och byggnader
varit de frimsta anvindningsomradena. Men det
finns ocksd fantastiska HDR-bilder av till exempel
bilar, makrobilder och portritt.

Négra exempel pa situationer da HDR-tekniken
kommer till sin rdtt dr nédr du fotar i skymning eller
gryning, snolandskap och inuti kyrkor. Ett bra knep
for att se om motivet har stérre dynamiskt omfang
dn kameran klarar av dr att ta en testbild och stude-
ra histogrammet. Om inte alla toner kan registreras
av kameran blir det hdga staplar i vinster- och/el-
ler hogerkanten, vilket alltsa innebdar att detaljer har
Klippts bort.

-

i fi

Ett histogram som fyller ut hela skalan &r ett sékert tecken pa att kameran inte kan
fanga hela det dynamiska omfanget.

Kanske har du sett HDR-bilder
med motiv som langt ifran &r
statiska, exempelvis vattenfall,
flaxande faglar och trafikkaos.
Da handlar det om nagot som ib-
land kallas »fusk-HDR«. Det gar
i regel ut pa att du utgar ifrdn en
enda exponering och efterharmar
kontrastékningen som sker i ton-
mappningssteget. | Photoshop
CS5 finns en funktion som helt &ar
dedikerad till detta under Image
> Adjustments > HDR toning
(bild > redigera > HDR-toning).

Det gér att skapa HDR-kénsla i
rérliga motiv med hjélp av olika
specialfunktioner.
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MED KAMERAN

Det finns lite olika skolor for hur manga bilder du
maste ta och hur stor skillnad det ska vara mellan
dem. Numera ér de flesta Gverens om att tre expo-
neringar med 2 EV skillnad rédcker i de allra flesta
fall. Du platar da alltsd motivet med den bésta ex-
poneringen du kan astadkomma. Dairefter tar du
tva versioner till, en som &r underexponerad tva
steg och en som dr verexponerad tva steg.

Normal exponering.

Underexponerat tva blandarsteg.

Overexponerat tva blandarsteg.

Har du en hyfsat modern systemkamera kan du
gora detta automatiskt med hjdlp av funktionen ex-
poneringsgaffling (eng: exposure bracketing). Titta 1
din kameramanual for att lista ut hur du gor pa just
din modell (vissa tillverkare later dig inte stélla in
intervallet 2 Ev. Vilj da fem bilder med 1 Ev skillnad
och kasta mellanbilderna).

Att tdnka pa:

Nagra saker som &r bra att téanka pa nar du fotogra-

ferar HDR-bilder:

+ Anvidnd stativ. Skakningsoskarpa forstor alla
dina chanser till en bra HDR-bild. Eftersom det
ofta blir langa slutartider nar du Gverexponerar
ar ett stativ ett viktigt hjadlpmedel.

¢ Ldas bldndaren. Du vill inte fa ett varierande
skarpedjup i kéllbilderna. Fotar du inte i manuellt
lage bor du alltsa stélla kameran pa blandarforval.

+ HAll ISO lagt. Brus kan vara sarskilt problema-
tiskt nér du arbetar med HDR. Hall ner ISO-talet
sa gott du kan.

+ Fota i RAW-format. Det gar utmarkt att géra
hdr-liknande bilder av jpeg-filer, men i strikt
mening &r det inte dkta HDR eftersom informa-
tionsméangden i en jpeg-bild inte racker till. En
RAW-fil kan lagra ett stérre dynamiskt omfang.

+ Gor inga onédiga RAW-instdllningar. Det ar 16n-
16st att arbeta med reglagen i din rdkonverterare
eftersom hdr-programmet bortser ifrén alla instéll-
ningar. Undantagen &r vitbalans och beskérningar.

¢ Rér inte kameran. Anvand antingen en fjarr-
rutlésare eller kamerans sjélvutlsare sa att alla

tre bilder tas i en f6ljd utan att du behéver fingra
pa nagra knappar.
Kontrollera alltid dina bilder sa att du sakert far med
alla detaljer. Ibland &r det dynamiska omfanget sa
stort att det kan krévas ytterligare exponeringar for
att fanga allting.

VID DATORN

I Photoshop hittar du HDR-funktionen under File >
Automate > Merge to HDR Pro (arkiv > automatisera
> lagg samman till HDR Pro) déar du inleder med att
lokalisera dina killbilder.

Ett vanligare tillvigagangssétt &r annars att
du markerar kéllbilderna direkt i Bridge -eller
Lightroom och 6ppnar Photoshops HDR-funktion
dérifran. I Bridge gor du det via menyn Tools >
Photoshop (verktyg > Photoshop). 1 Lightroom kan
du istéllet hogerklicka pa bilderna och vilja Edit in
(redigera i).
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Naér du har startat funktionen och valt kallbilder
kan det krdvas en stor portion tdlamod. Allting sker
lyckligtvis snabbare i cs§ jamfort med tidigare ver-
sioner, men det kan fortfarande ta rejilt med tid nir
du arbetar med hégupplosta RAW-bilder.

Sa smaningom dyker en dialogruta upp dar du
gor alla instdllningar som definierar din RAW-bild.

-~ ey to HOR Pro 77,300,

rmal.jpg

Genom att starta HDR-funktionen direkt fran Bridge eller Lightroom slipper du leta upp kallbilderna i ett senare skede.

Manga av reglagen kidnner du sidkert igen fran Ca-
mera Raw, exempelvis Exposure (exponering), Sa-
turation (mdttnad) och Vibrance (lyster). Det bésta
séttet att f4 en uppfattning om hur de 6vriga regla-
gen paverkar bilden &r att dra fram och tillbaka och
studera forhandsgranskningen.

Liangst upp kan du vilja redigeringsldge. Det
bor alltid sta instillt pa 16 bit och Local Adapta-
tion (lokal anpassning). 32 bits-ldget kan ju lata fres-
tande men eftersom din skdrm inte kan visa ett sa

Mode: (1680 58 | Local adamatan 8

iage low

Merge to HDR Pro &r som
ett litet eget program i
programmet. Vanliga Pho-
toshop ér otillgangligt tills
Geel 3 @k 9 | du ldamnar dialogrutan.

stort bitdjup har du normalt sett ingen anvind-
ning for det.

Om du kdnner dig vilsen forsta gangen du 6pp-
nar HDR-funktionen kan du ocksa vilja en forinstill-
ning i rullmenyn lidngst upp. Problemet ér att stan-
dardvérdena ér valda efter vad amerikaner tycker dr
»fint«. Testa till exempel Photorealistic (fotorealistisk)
sé forstar du vad jag menar. Forinstéllningarna kan
pa sin hojd fungera som utgangspunkt for vidare
experimentering.
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Har du en dldre Photoshop-
version?

Det har gatt att skapa HDR-bilder
direkt i Photoshop sedan version
CS2. Men det &r forst i CS5 som
funktionen borjar bli anvandbar.
Det mesta fungerar visserligen li-
kadant pa ytan, men under huven
ar algoritmerna helt omarbetade.
Ager du inte CS5 och vill jobba
med HDR bér du 6vervéaga att
skaffa Photomatix Pro som om-
namns sist i den hér artikeln.
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Sd behdller du realismen

Reglagen i HDR Pro péverkar varandra och till en
borjan kan det vara svart att hitta en lémplig ord-
ning. Om du féredrar den mer realistiska sidan av

HDR kan du félja mitt recept nedan. Det passar inte
alla bilder men kan bli en bra startpunkt foér dina
egna finjusteringar.

01 Borja med att justera Radius (radie). Vart regla-
get ska hamna beror lite pa hur mycket detaljer
din bild har. Bilder med fa detaljer tal en hogre
radie. Anvénd ditt eget 6ga for att bedéma vilket
ungefarligt varde som kénns bast. (Du kommer
att dterkomma till radien i slutskedet och stalla
in ett mer exakt vérde).

02 Dra sedan forsiktigt i Strength (styrka). Sa fort
du ser att det bérjar uppsta haloeffekter runt
konturerna stannar du och backar en aning.

dig bra stdd nér du testar. Vissa bilder mar ocksa
bra av ett riktigt hogt varde pa hégdagrarna som
sedan kompenserar med en 6kning av gamma-
vardet.

07 Vilka varden du véljer pa Saturation (mdttnad)
och Vibrance (lyster) &r helt upp till dina egna
preferenser. Vill du at realism bér du dock akta
dig for att krdma pa for mycket férg.

08 Avsluta med att ga tillbaka till reglagen fér Edge
Glow (kantgléd) langst upp. Ibland kan dina an-
dra justeringar gora att du maste finjustera radie
och styrka en aning.

Léangst ned finns ocksa en flik som ger dig méjlighet

att justera en tonkurva. Det kan ofta behovas for

att hitta ratt kontrast, men ett battre alternativ &r

att 6ppna bilden i Photoshop och géra den typen av

justeringar dar istéllet (se nedan).

Den nya funktionen i Photoshop cs5 har ocksa ut-
rustats med ett sétt att avhjdlpa ett problem som
gdckar manga HDR-entusiaster. For hur noga du én
dr med stativ och valet av motiv dr det inte alltid
mojligt att undvika att ndgot i scenen ror sig. Va-
jande trddgrenar, flygande faglar eller till och med
manniskor kan stilla till bekymmer. Resultatet i
HDR-bilden brukar bli nagon slags spokskepnad
som inte liknar nagonting.

i ST e SA SLIPPER DU PROBLEM MED
— ‘ﬁ OBJEKT | RORELSE

Tar du i for mycket styrka uppstar fula haloeffekter kring bildens
konturer. Rétt styrka &r i regel strax innan dessa defekter uppstar.

03 Hoppa 6ver Gamma tillfélligt och justera Expo-
sure (exponering) om du finner det nédvandigt.
Det &r inte ovanligt att bilden behéver ljusas upp
eller morkas ner en aning.

04 Om du okar exponeringen i steg 3 kan det handa
att bilden ljusaste partier tappar sitt fina utse-
ende. Dra darfér Gamma forsiktigt till hoger tills
du aterfar fina hogdagrar, men gé absolut inte
far langt.

Genom att forsiktigt 6ka Gamma-vardet kan du aterhdmta forlorade
hégdagrar.

05 Nu kommer det farligaste reglaget. Genom att
o6ka Details (detaljer) kan du fa fram lite mer
stuns i bilden. Det fungerar ungefar som Clarity
(klarhet) i Camera Raw. Men drar du far langt far
du det animerade utseendet som kénnetecknar
6verdrivna HDR-bilder. Férsiktighet &r det alltsa
som galler.

06 Shadow (skuggor) och Highlights (hégdagrar)
anvander du om du vill ljusa upp eller mérka ner

Ménniskor som rért sig mellan exponeringarna &r ett problem
som kan avhjélpas med funktionen fér fantomskuggor.

dessa tonomraden. Férhandsgranskningen ger

5 2 Photoshop, HDR



Hittar du sadana defekter i din bild kan du prova
att kryssa i rutan Remove ghosts (ta bort fantom-
skuggor) lingst upp. Nar du gor det markeras en
av dina exponeringar i nederkanten med en gron
ruta som beréttar vilken bild Photoshop tror ér den
bista. Klicka pa de andra bilderna for att byta prio-
ritering.

Nar du slutligen dr ndjd med din HDR-konverte-
ring klickar du oK for att 6ppna bilden i Photoshop.

HDR-BILDER BEHOVER BILDBEHANDLAS

Ett vanligt misstag dr att betrakta bilden som helt
Kklar efter HDR-steget. Men ndr det kommer till van-
lig bildbehandling &r HDR-funktionen pa manga sitt
ett trubbigt verktyg. Vill du fa bésta maojliga resultat
bor du utnyttja Camera Raw och Photoshop for att
gora din avslutande bildbehandling, sdrskilt nir det
giller finjustering av svart- och vitpunkt, kontrast
samt brusreducering.

Utover dessa grundjusteringar kan det hidnda
att du behover stidda upp lite i bilden dédr HDR-sam-
manslagningen fatt problem. Vanligast &r att det har
uppstatt ndgon konstig skarv eller att funktionen
for fantomskuggor har misslyckats. Anviand klon-
stimpeln eller lagningspenslen for att atgérda detta.

HITTA RATT AVVAGNING

Du har tidigare sett hur du genom att vara varsam
med reglagen i HDR-steget kan se till att effekten blir
aterhallsam. Men tillhor du de lite mer konservativa
kanske du finner dven den typen av bilder lite for
extrema. Trots det finns det dnnu inte anledning att
avfiarda HDR-tekniken. Genom att tona ihop HDR-
versionen med en vanlig exponering bestimmer du
nidmligen precis hur mycket effekt du vill ha.

Genom att tona ihop HDR-bilden med originalet pa olika s&tt kan
du fa precis s& mycket effekt du sjélv 6nskar.

A 100% EA50% H 0%

Det har ocksd den fordelen att du inte behdver
vara lika forsiktig ndr du skapar HDR-varianten. Du
véljer ju sjdlv hur mycket effekten ska sla igenom i
slutdndan.

Sda gér du

Borja med att markera och kopiera HDR-varianten
av motivet. Oppna sedan din basta exponering av
den aktuella bilden och klistra in.

For att forsdkra dig om att bilderna &r perfekt
6verlagrade markerar du bada lagren och kér Edit
> Auto-Align Layers (redigera > justera lager auto-
matiskt).

Valj darefter nagon av nedanstadaende metoder
for att jobba dig fram till en perfekt avvéagning.

Blanda med opacitet

Snabbaste sattet att tona ned effekten &r att an-

vanda lageropacitet.

+ Sank opaciteten for HDR-lagret tills du hittar en
lagom sammanblandning.

Blanda med lagermask

Nar du sénker opaciteten avtar HDR-effekten lika

mycket oéverallt i bilden. Vill du ha ett mer selektivt

resultat kan du anvénda en lagermask i stéllet.

+ Lé&gg till en lagermask fér HDR-lagret genom att
klicka pa den lilla torktumlarsymbolen langst ned
i lagerpanelen.

+ Anvand en svart eller gré pensel och méla i mas-
ken for att avlagsna hdr-effekten innan du gér
en slutavvagning med hjélp av lageropaciteten.

ARKEOLOGMETODEN
Den absolut bésta metoden for att f4 lagom mycket
effekt dr den sa kallade arkeologmetoden. Den gar
ut pa att du sakta men sdkert penslar fram effekten
tills du blir nojd.
» Ligg till en lagermask pa HDR-lagret
och gor den helt svart genom att trycka
Ctri+l pa tangentbordet. Resultatet blir
att HDR-effekten helt goms undan.
* Vilj en vit, mjuk pensel och sidnk opaci-
teten for penseln till ungefar 10-15%. Ar-
beta med upprepade drag i lagermasken
for att plocka fram lite effekt at gangen.
Ar du vildigt noggrann kan du ocksé ligga HDR-

versionen tillsammans med samtliga tre expone- >
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Blanda med opacitet.

| Narmal %] opacity: 100x ]

Lock: s+ a

»
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Blanda med lagermask.
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DEN DETALJRIKEDOM EN

SMAKFULLT AVVAGD HDR-BILD

KAN UPPVISA GAR INTE ATT

MATCHA PA ANNAT VIS. suscssencn

54 Photoshop, HDR

ringar i ett och samma Photoshopdokument. Det
ger dig en perfekt mojlighet att ta det bidsta fran
varje bild. Hittar du exempelvis utfritta hogdagrar
kan du »laga« dem genom att forsiktigt maska fram
den morka exponeringen.

Tips: Vill du se mer om hur arkeologmetoden fung-
erar 1 praktiken hittar du en videoguide pa www.mo-
derskeppet.sefvideo

PHOTOSHOP AR INTE DET BASTA
ALTERNATIVET

Merge to HDR Pro har den fordelen att den dr di-
rekt tillgdnglig om du &r dgare av Photoshop. Men
det finns béttre programvara om du verkligen vill ta
ditt HDR-skapande ett steg ldngre. I det fristdende
programmet Photomatix Pro blir bilderna snyggare
och justeringsmojligheterna ar fler. Dessutom é&r
Photomatix Pro enormt mycket snabbare dn kusin-
en i Photoshop.

Photomatix Pro kostar $99 och kan laddas hem
via www.hdrsoft.com. Dér hittar du ocksa en prov-
version om du vill verifiera kvalitetsskillnaden innan
du bestimmer dig.

ALLT HANDLAR OM ATT UTNYTTJA
HDR-TEKNIKEN PA RATT SATT

Jag hoppas att du som tidigare var odelat skeptisk
till HDR har fatt anledning att revidera din uppfatt-
ning efter att ha ldst den hér artikeln. Den detaljri-
kedom en smakfullt avvigd HDR-bild kan uppvisa
gar inte att matcha pa annat vis. Ligg dartill att
HDR-tekniken kan ge dig ett perfekt sitt att undvika
utfratta hogdagrar och ihopgrotade skuggor i pre-
cis den utstrickning du sjilv bestimmer. Vad spe-
lar det da for roll att vissa anvander tekniken for att
skapa hallucinogena bilder?

Ar inte HDR onédigt?
Né&r du arbetar med lagermasker fér att tona ihop

dina bilder slas du kanske av tanken att allt HDR-
arbete &r i onddan. Gar det inte lika bra att lagga alla
exponeringar i Photoshop direkt och maska fram
ratt exponering i ratt tonomrade?

Jo, pa sétt och vis. Men det finns en avgérande
skillnad, férutom att det ar skont att slippa mask-
ningen som emellanat &r valdigt kranglig. | fallet
med en 32-bitars HDR-bild jobbar algoritmerna
bade globalt och lokalt. | praktiken innebér det att
aven omgivningen kring varje pixel har inflytande
pa det slutgiltiga utseendet. Pa sa satt kan den lo-
kala kontrasten behallas i hogre grad an vad som &r
mojligt nér du bara slar ihop exponeringarna direkt
i Photoshop. Skillnaden marks framfor allt nér det
dynamiska omfanget é&r riktigt stort.

ANNONS

Bli en bittre
fotograf &
bildbehandlare

Genom Kamera & Bild kan du anmala
dig till olika kurser och workshops pa
Fotografiska Akademin i Stockholm.

Vi kommer framdver dven att erbju-
da unika kurser for dig som ar Kamera
& Bild-lasare.

Nagra av kurserna dr:
Ditt personliga bildsprak

Kursledare: Géran Segeholm

Designa din egen fotobok
Kursledare: Martin Skoog & Géran Segeholm

Utveckla ditt fotografiska seende

Kursledare: Hannah Goldstein

Bildbehandling Photoshop |

Kursledare: Bosse Kinnas

Se bilden

Kursledare: Géran Segeholm

Workshop - Street photography
Kursledare: Martin Skoog

Workshop - Portratt med modell
Kursledare: Martin Skoog

Las hela listan med kurser pa:
www.fotografiska.se/akademin

Anmal ditt intresse till:
kurs@kamerabild.se
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